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 1 Intention
The intention of this document is to create a manual for the standard computer
user wanting to use Linux. 

ONE machine – ONE operating system – ONE manual.

 2 Version
See Engineers Manual.

 3 Tech manual
Is the setup of systems which the final user will see in the User Manual.

 4 Linux issue
The issue with Linux is that it is too configurable and when the standard user 
talks to Linux Nerds they get too much info and too many options. I think the 
standard home and business user wants a system which is holistically a 
machine and OS with a manual. Like Puri.sm or Apple I am trying to create a 
system where the machine and OS are one design. 
Because: 

a) I am not as determined as Puri.sm or Apple to build from scratch and 
b) the only reason I’d NOT bought one of the Puri.sm machines Is the warranty 

time difficulty between Australia and USA
I have taken the path of buying a 3rd party machine and trying to get as close 
to the unified system ideal as possible.

 5 Why this machine?
 5.1 I had a very reliable Toshiba before;
 5.2 My old boss from 20 years ago still stands by and sells Toshiba;
 5.3 Toshiba has a 3 year manufacturer warranty as standard;
 5.4 Warranty covered Australia wide and most likely in most countries;
 5.5 Backlit keyboard;
 5.6 Metal chassis – Magnesium Alloy for durability;
 5.7 Hi res screen;
 5.8 Hopefully reasonable graphics card;
 5.9 RJ-45 connector;
 5.10 Reasonable ports – USB, Thunderbolt, STANDARD HDMI, MicroSD 

card reader, earphone.
 5.11 Toshiba appear to build to industry standards and not make up some

propriety new mangled standard like Apple, Acer or IBM. --- You 
here me out there manufacturers!!! If manufacturers make 
proprietary rubbish with no manuals and parts that are designed 
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to fail so I have to come back to you to buy them, I will do 
everything in my power to buy somewhere else and tell everyone 
else to buy something else!! 

 5.12 Highly likely to be Linux compatible.

 6 Improvement suggestions
 6.1 Build in the PSU. 90% of laptop users cart their PSU around with 

them. Thus all the wires hanging off the PSU WILL break and it 
adds to the weight anyway. Reduce the weight by building the 
PSU into the chassis as a separate replaceable unit. NO extra wire 
from the PSU to the Laptop.

 6.2 Make a magnetic IEC adaptor. For the PSU. Apple did the magnetic 
connector years ago. They did a horrible job of it, but it’s still 
better than the rest of the manufacturers. IEC plugs are 
everywhere. Make a separate PSU which connects magnetically to
the chassis, but streamlined into the chassis. If someone trips 
over the cable it will still come off. It sits smooth with the chassis 
so fits into a laptop sleve.

 6.3 IEC connectors to the PSU. They are everywhere so there is no need 
to carry any extra cables in transit.

 6.4 12 volts through the IEC connector. Auto sensing switch mode PSUs 
have been around for ages. Add 12v to the 120v and 240v auto 
sensing.

 6.5 Mechanical replaceable switches on the camera, microphone, wifi & 
GPS.

 6.6 A non back lit monochrome LCD screen like an e-reader except as a 
laptop. Colour would be nice, but I’ve not checked the colour e-
readers as yet. The eye strain on a non back lit screen I find to be 
substantially less. It would also make a mammoth power saving.

 6.7 Waterproof keyboard?? It’s 2021 people. One of the most common 
ways a notebook PC is damaged it through liquids. Where is the 
waterproof keyboard or I should as whole machine?

 6.8 Singe click on a filename to go into edit filename mode instead of 
right clicking and selecting ‘Rename’.

 6.9 When double clicking on the column divider in Caja, the column 
expands or contracts to the width of the max length file name like
IOS or windows XP. 

 6.10 Drag a file with the right mouse button held and where it drops 
another menu comes up with the options:

 6.10.1  Create link here
 6.10.2  Copy
 6.10.3  Move
 6.10.4  Extract here.

 6.11 Pinch zoom working as standard
 6.11.1  Found an interim solution here:

https://forums.linuxmint.com/viewtopic.php?
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 6.12 Touch pad two finger rotate as standard.

 6.13 Caja file browser
 6.13.1  Column browser like Mac for Caja with the preview panel as 

the last panel.
 6.13.2  After doing a search when a single click on a file is 

performed, show the path somewhere without having to 
go into 
right click → ‘Properties’

 7 Description
This document outlines the setup of a Toshiba Dynabook Portege X3.0L-J 
notebook computer running Linux Mint version 20.1.

 8 The machine
Taken from:
Menu → System Reports → System Information.

System:    Kernel: 5.8.0-48-generic x86_64 bits: 64 compiler: N/A Desktop: 
MATE 1.24.0 wm: marco 
dm: LightDM Distro: Linux Mint 20.1 Ulyssa base: Ubuntu 20.04 focal 
Machine:   Type: Laptop 
System: Dynabook 
product: PORTEGE X30L-J v: PCR10A-02P003 serial: <filter> 
Chassis: type: 10 v: Version 1.0 serial: <filter> 
Mobo: Dynabook model: A010D/0001 v: 

Version A0 serial: <filter> UEFI: Dynabook 
           v: Version 1.90 date: 02/04/2021 
Battery:   ID-1: BAT1 charge: 37.7 Wh condition: 54.1/53.1 Wh (102%) 

volts: 15.7/15.4 
model: G71C000M8221 serial: <filter> status: Discharging 

CPU:       Topology: Quad Core model: 11th Gen Intel Core i5-1135G7 bits: 64
type: MT MCP 

           arch: Tiger Lake rev: 1 L2 cache: 8192 KiB 
           flags: avx avx2 lm nx pae sse sse2 sse3 sse4_1 sse4_2 ssse3 vmx 

bogomips: 38707 
           Speed: 851 MHz min/max: 400/4200 MHz 

Core speeds (MHz): 1: 608 2: 969 3: 3480 4: 1269 
           5: 1080 6: 666 7: 3437 8: 1064 
Graphics:  Device-1: Intel driver: i915 v: kernel bus ID: 00:02.0 chip ID: 
8086:9a49 
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           Display: x11 server: X.Org 1.20.9 

driver: modesetting unloaded: fbdev,vesa 
           compositor: compiz resolution: 1920x1080~60Hz 
           OpenGL: renderer: Mesa Intel Xe Graphics (TGL GT2) v: 4.6 Mesa 
20.2.6 
           direct render: Yes 
Audio:     Device-1: Intel driver: snd_hda_intel 

v: kernel bus ID: 00:1f.3 chip ID: 8086:a0c8 
Sound Server: ALSA v: k5.8.0-48-generic 
Network:   Device-1: Intel 

driver: iwlwifi v: kernel 
port: 3000 bus ID: 00:14.3 chip ID: 8086:a0f0 

          IF: wlo1 state: up mac: <filter> 
           Device-2: Intel Ethernet I219-V 

driver: e1000e v: 3.2.6-k port: efa0 bus ID: 00:1f.6 
           chip ID: 8086:15fc 
           IF: eno2 state: down mac: <filter> 
Drives:    Local Storage: total: 931.51 GiB used: 492.28 GiB (52.8%) 
           ID-1: /dev/nvme0n1 

vendor: Crucial model: CT1000P1SSD8 size: 931.51 GiB 
           speed: 31.6 Gb/s lanes: 4 serial: <filter> 

Partition: ID-1: / 
size: 915.40 GiB used: 492.27 GiB (53.8%) fs: ext4 dev: 

/dev/nvme0n1p2 
USB:       Hub: 1-0:1 info: Full speed (or root) 

Hub ports: 1 rev: 2.0 
chip ID: 1d6b:0002 

           Hub: 2-0:1 info: Full speed (or root) 
Hub ports: 4 rev: 3.1 chip ID: 1d6b:0003 

           Hub: 3-0:1 info: Full speed (or root) 
Hub ports: 12 rev: 2.0 chip ID: 1d6b:0002 

Device-1: 3-5:2 info: Siliconworks SiW HID Touch Controller type: HID 
           driver: hid-generic,hid-multitouch,usbhid rev: 2.0 chip ID: 
5348:1201 
Device-2: 3-6:3 info: Chicony Web Camera - HD type: 
Video driver: uvcvideo rev: 2.0 
          chip ID: 04f2:b6f0 
Device-3: 3-10:4 info: Intel type: Bluetooth driver: btusb rev: 2.0 chip ID: 
8087:0026 
  Hub: 4-0:1 info: Full speed (or root) 

Hub ports: 4 rev: 3.1 chip ID: 1d6b:0003 
Sensors:   System Temperatures: cpu: 53.0 C mobo: 53.0 C 
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           Fan Speeds (RPM): N/A 

 9 Install
Once you’ve acquired your X30 you’ll need to download the image file from 
linuxmint.com. From here you will create a boot thumb drive from that .iso 
image using the installation guide.
Stick the thumb drive in the USB port and turn on the computer. Keep pressing 
F2 to get into the BIOS. 
In the BIOS you can choose the boot order. Select to boot from the thumb drive
via USB. The machine should now boot into the Linux Mint OS running from the
thumb drive. It will have an option there to install the OS. Choose it and select 
the default options.

 10 Installing the correct Kernel
See Fixing the suspend issue – Part I.

 11 LAN driver
e1000e-3.8.4.tar.gz
Available from either:
https://dionpatelis.com/mint-20-1-desktop-on-x30l-j/
or
https://downloadcenter.intel.com/download/15817
Instructions from intel:
https://www.intel.com/content/www/us/en/support/articles/000005480/
network-and-i-o/ethernet-products.html
Summarised into:
Prerequisites

apt-get install linux-headers-$(uname -r)
apt-get install gcc make

You may need to perform a general update and restart before the next steps.

Download current e1000e package from Download Center. Move the base 
driver tar file to the directory of your choice.
For example, use 

/home/<USERNAME>/e1000e or /usr/local/src/e1000e.

Untar/unzip the archive, where <x.x.x> is the version number for the driver tar
file:

    tar zxf e1000e-<x.x.x>.tar.gz

Change to the driver src directory, where <x.x.x> is the version number for 
the driver tar:

    cd e1000e-<x.x.x>/src/

Compile the driver module:
    make install

The binary installs as:
/lib/modules/<KERNEL 
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VERSION>/kernel/drivers/net/e1000e/e1000e.ko

The install location listed above is the default. Location may differ for various 
Linux distributions.
Load the module using either the insmod or modprobe command:

    modprobe e1000e insmod e1000e

Note: You can use the insmod command for 2.6 kernels if you specify the full 
path to the driver module. For example:

insmod /lib/modules/<KERNEL 
VERSION>/kernel/drivers/net/e1000e/e1000e.ko

With 2.6 based kernels, make sure that older e1000e drivers are removed from
the kernel before you load the new module:

    rmmod e1000e; modprobe e1000e

Assign an IP address to the interface by entering the following, where <x> is 
the interface number:

    ifconfig eth<x> <IP_address>

Verify that the interface works. Enter the following, where <IP_address> is the 
IP address for another machine on the same subnet as the interface you're 
testing:

    ping <IP_address>

 12 Audio driver
Quoted from forum thread:
“As I said the sound driver I was running was sof-audio-pci, which had no 
normal firmware at the moment.
I searched nearly 3 hours trying to solve this headache and finally found the 
solution, just disable this "sof" driver and fall back to intel:
Do:

sudo gedit /etc/default/grub

Change
GRUB_CMDLINE_LINUX_DEFAULT="quiet splash"

to:
GRUB_CMDLINE_LINUX_DEFAULT="quiet splash 
snd_hda_intel.dmic_detect=0"

Then do:
sudo update-grub

and Reboot.
You can check if soundcards are detected with:

aplay -l

Thread reference:
https://askubuntu.com/questions/1243369/sound-card-not-detected-ubuntu-20-
04-sof-audio-pci
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 13 Fixing the suspend issue – Part I
Out of the box when you try click suspend the screen will go black and then it 
will come back to life. To fix this load the correct kernel as usually it’s a 
graphics driver issue.
To check if you have a graphics driver loaded:

inxi -Fxxxrz

It will throw back:
Graphics:
Device-1: Intel driver: N/A bus ID: 00:02.0 chip ID: 
8086:9a49 
Display: x11 server: X.Org 1.20.9 driver: fbdev unloaded: 
modesetting,vesa compositor: compiz v: 0.9.14.1 resolution: 
1920x1080~77Hz 
OpenGL: renderer: llvmpipe (LLVM 11.0.0 256 bits) v: 4.5 
Mesa 20.2.6 
compat-v: 3.1 direct render: Yes 

showing that the graphics driver is not loaded.
User SMG on the Mint forums said:
“Given how new your processor is, I would first recommend switching to the 
5.8 kernel which is available in Update Manager.
Open Update Manager. Select View > Linux Kernels and click Continue. Make 
sure 5.8 is selected on the left panel and then click the top-most option on the 
right panel. An "Install" button will appear. Install the kernel and then reboot 
for it to become active.
Let's see if that loads the i915 driver, modesetting, and the Intel renderer.” 
I did so and now it works. The screen turns off:

Graphics:
Device-1: Intel driver: i915 v: kernel bus ID: 00:02.0 chip 
ID: 8086:9a49 
Display: x11 server: X.Org 1.20.9 driver: modesetting 
unloaded: fbdev,vesa compositor: compiz v: 0.9.14.1 
resolution: 1920x1080~60Hz 
OpenGL: renderer: Mesa Intel Xe Graphics (TGL GT2) v: 4.6 
Mesa 20.2.6 direct render: Yes 

Forum reference:
https://forums.linuxmint.com/viewtopic.php?f=47&t=346619

 14 Suspend issue – part II
Laptop wont stay in suspend.
For a list of devices that wakeup the computer:

    cat /proc/acpi/wakeup

The 4 letter codes are specific to manufacturer so are a bit hard to figure out.
You can grep in 

    cat /proc/bus/input/devices

for the codes shown in 
    cat /proc/acpi/wakeup

For the Portege I found that if I disabled:
    RP08
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it appears to put the system to sleep except the screen is like in a black on 
state with a non blinking cursor. This concerns me as it would still be using 
power.
To disable

    echo RP08 | tee /proc/acpi/wakeup

Forum reference:
 https://forums.linuxmint.com/viewtopic.php?f=90&t=261465&start=20

 15 Enable hibernate
You have to create a separate swap partition of at least double your RAM. On 
the Toshiba Portege X30 series Gparted did not seem to work from the iso on 
the Gparted web site. I used the original install boot USB for Linux Mint Mate 
and ran Gparted from there in the Gnome Gui. I resized the main partition 
down and added the Linux swap partition using these instructions.
https://linoxide.com/how-to-create-new-swap-partition-on-rhel/
From here I followed this post:
https://forums.linuxmint.com/viewtopic.php?
f=49&t=357914&p=2072613&hilit=hibernate#p2072613

----------------------------------------
First of all, you will want to resize the swap partition to double the 
size of your RAM (in this case, 32 GB or 34,359,738,368 bytes), so 
that hibernation can safely suspend to RAM.

Second, make sure Secure Boot is disabled in your BIOS settings.

Third, open the command line (terminal), and type in the following:

sudo -i

(Type in your password)

echo -e "[Enable hibernate in upower]\nIdentity=unix-
user:*\nAction=org.freedesktop.upower.hibernate\
nResultActive=yes\n\n[Enable hibernate in logind]\
nIdentity=unix-user:*\
nAction=org.freedesktop.login1.hibernate\
nResultActive=yes" >> /etc/polkit-1/localauthority/50-
local.d/enable-hibernate.pkla

Next, close that terminal window, and open up a new terminal 
window. Type in the following:

inxi -u

Copy the 'uuid' value of your swap partition to somewhere - you're 
going to need that later on.
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Next:

sudo -i

(Type in your password)

xed /etc/default/grub

This will open up the text editor for the 'grub' file.

Look for the line of text that says
GRUB_CMDLINE_LINUX_DEFAULT="quiet splash"

Now, you're going to need to paste the 'uuid' value from earlier. 
Change that line of text within the 'grub' file to
GRUB_CMDLINE_LINUX_DEFAULT="quiet splash 
resume=UUID=PASTE THE UUID VALUE HERE"

Save the 'grub' file, and close the text editor.

Finally, in a new terminal window, type in the following:

sudo update-grub

(Type in your password)

After that, restart your computer, and then make sure hibernate 
works properly thereafter.
----------------------------------------

 16 Compiz – the ultimate window manager
By far the smoothest window manager I’ve ever used. It looks like it’s there out
of the box with Linux Mint, but it just never works.
(If the Linux Mint team are reading this, could you please make a big fat button
in the ‘Control Centre’ to set the following up automatically? Other than that, 
you guys have made an awesome OS, thank you and keep up the fantastic 
work.)
Mac OSX took some Compiz components and added them to make a very slick 
OS (Up to OSX 10.6.9)

 16.1 Setup
Linux Mint Mate 19.3 & 20.1
It needs to be setup in Mint Mate
Go to a terminal session for the current user.
compiz --replace
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then you can configure everything else from the 'Control Centre' 
menu item.

To make it start automatically for that user:
Menu → type 'startup applications'
Add the 
compiz --replace

command
Logout and in again.
Voila!

 16.2 Wobbly windows
I love wobbly windows as it makes the desktop feel organic. Also 
because my eyesight is diminishing due to age, the Zoom in 
‘Enhanced Zoom Desktop’ is great. I’ve set to <alt>Button4 and 
<alt> Button5 which is <alt> scroll to zoom in and out smoothly.

 16.3 Desktop switcher cube
The ‘Enable Rotate Cube’ Compiz setting I’ve set to <ctrl><alt> left 
and right arrows makes desktop switching impressive and easy for 
the brain to handle.

 16.4 Grid
The grid system allows a user to grab the title bar of a window and 
drag it into the side, top or corner of the screen causing it to resize.
These settings are managed in
Control Centre → Compiz Config → Grid.
Shortcut keys
<Alt> key and then one of the following:
q,w,e
a,s,d
z,x,c
with <Alt><Shift>s to restore to the original window.

 16.5 Shift switcher

 16.5.1  To enable
Control Centre → Compiz config → Enable Application 
Switcher→ disable all Bindings except → Next Window (all 
windows) → <Alt><Super>Tab
Then
Control Centre → Compiz config → Enable Shift switcher → 
Next Window key (All Workspaces) → set to <Alt>Tab
&
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Previous Window key (All Workspaces) → set to 
<Shift><Alt>Tab

 16.5.2  Window Title display
Choose → Window Title Display from the top tab in the → 
Enable Shift Switcher → Enable it → Choose bold → Choose
a dark background colour and a light Font colour.

 16.5.3  Switching between windows of the same 
application
The user manual shows → Switching Between Windows → 
Between the same application.
For switching between windows of the same 
applications:
→ Enable Shift Switcher → Next Window Key (Group) → set 
to <Alt>grave 
which is equivalent to 
<Alt>tilde
or
<Alt>~

 17 Keyboard
It’s keystrokes are not as smooth as a lot of other keyboards I’ve tried, but I 
can see how maybe some would prefer it. 
Size is nice and having ‘page up’ & ‘page down’ is excellent.
Water proof or splash resistant ???

 18 Screen
The screen seems a little flexi for my liking initially. However it may be fine. To 
get a laptop under 1kg is quite a feat. As much as I liked the durability of a 
toughened glass screen by Apple, it’s glossy reflection drove me mad on many 
an occasion, thus a matte screen is far nicer to work on. After 10 years the 
glass screen on the MacBook still looks new. We’ll see how the X30 screen 
stands up to the test of time. The Toshiba did come with a soft cloth to keep 
between the screen and the keyboard though. And in Toshibas defence, the 
first Tecra A40 I had between ~2005 and 2010 I did not put anything between 
the screen and the keyboard when closed and in transit it did scratch the 
screen, and thus the MacBook Pro always had a piece of foam between screen 
and keyboard in transit without fail.

 18.1 Touch screen
This works out of the box. In Brave web browser it scrolls in all 
directions and pinch zoom works beautifully. Just can’t get pinch 
zoom working with the touchpad.
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 18.2 Brightness
Fn F7 & F8 not working out of the box.
Using brightness applet on panel at the moment till I find a 
resolution. 
Have set 
<Alt>n 
and 
<Alt>m
as keyboard shortcuts for brightness.
To install:

apt install light

Add the user to /etc/sudoers so they don't have to type a password 
when issuing a sudo command. Type

visudo

to edit this file.
Add

%username% ALL=(ALL) NOPASSWD:/usr/bin/light

to the end of the file.
Insert your username where it says 

%username% 

above:
then in the 
Command Centre → Keyboard shortcuts
add the command
sudo light -A 5 and
sudo light -U 5
for 2 different key combinations being
<Alt>n 
and 
<Alt>m

This is fine for a single user for the moment once they are logged in.
Preferably the new Toshiba BIOS will just make the original Fn keys 
work.

Taken from the forum  post:
https://forums.linuxmint.com/viewtopic.php?
f=59&t=347211&p=2001741#p2001741

Note: the less secure version for trouble shooting in visudo is:
%username% ALL=(ALL) NOPASSWD:ALL
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Either bios update or something in X11 dir in the 
radeon.conf file

 19 Disabling the IME
Disabling the Intel Management Engine. Refer to blogs at Puri.sm

 20 ToDos
Setup inertia scrolling on the trackpad like OSX. So you can flick and it keeps 
scrolling.
 20.1 Check microphone.
 20.2 Get all the function keys working as Toshiba has designed.
 20.3 Get double click on the top of any given window to maximise 

working every time, not just sometimes.
 20.4 Get virtual machines running.

 21 Types of this document
The exports of this document is always done from the latest version of 
LibreOffice.
The .epub version: 
File → Export As → Export Directly as EPUB
File → Export → Select from the bottom RHS in the drop down menu XHTML → 
Save.

 22 Glossary
~ (tilde) = Approximately equal to
OS = Operating System
LAN = Local Area Network
RHS = Right Hand Side
LHS = Left Hand Side

 23 Forks
Feel free to fork these manuals. They are GNU licence.

 24 Notes
The base point for this information is at dionpatelis.com/linux

 25 Contact
You can contact me through forums.linuxmint.com. My username there is 
7rocks. You’ll have to register as a user. If it’s a legitimate question relative to 
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this manual, just post a new topic question on the forum.

 26 Contribute
If this manual has helped you and you feel you want to contribute to motivate 
me to refine it further, Please do so at
https://www.patreon.com/dionpatelis.
Really the best way to contribute is to fork this manual. Maybe make one for 
whatever hardware / OS you use. We are aiming at making a standard fully 
open source system from the first transistor and screw to the final polished 
user interface. If there are many, the best one should hold strong and the 
others will fall away. 
I am not saying the X30 is the final portable sub 1kg laptop. It was just the 
best option I could find in the time frame I had. It can not be unless Toshiba 
comes aboard and open sources every moulding / part in FreeCAD; then all the
chip manufacturers open source the internal circuit designs on KiCAD.
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